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License Agreement 
 
• BarBack is protected by copyright laws and international copyright treaties as well as other intellectual property laws and treaties.  

BarBack is licensed, not sold. 
• You may install and use one copy of BarBack on a single computer.  You may make a single backup copy of BarBack solely for 

archival purposes. 
• You may not reverse engineer, decompile, or disassemble BarBack. 
• BarBack is licensed as a single product.  Its component parts, including the drink database, may not be separated for use on more 

than one computer. 
• You may not rent or lease BarBack 
 
Limited Warranty 
 
              The information contained in this document is subject to change without notice.  Paul Knorr warrants that BarBack will perform substantially in accordance 
with the accompanying written materials for a period of ninety (90) days from the date of receipt.  Any implied warranties on BarBack are limited to ninety (90) days. 
                  Paul Knorr’s entire liability and your exclusive remedy shall be a return of the price paid provided it is returned within the warranty period with a copy of your 
receipt. 
                  To the maximum extent permitted by applicable law, Paul Knorr disclaims all other warranties, either express or implied, including, but not limited to implied 
warranties of merchantability and fitness to a particular purpose with regard to BarBack and the accompanying written materials.  This limited warranty  gives you specific 
legal rights.  You may have others which vary from state/jurisdiction to state/jurisdiction. 
                  To the maximum extent permitted by applicable law, in no event shall Paul Knorr be liable for any damages whatsoever (including without limitation, special, 
incidental, consequential, or indirect damages for personal injury, loss of business profits, business interruption, loss of business information, or any other pecuniary loss) 
arising out of the use of or inability to use this product.  In any case, Paul Knorr’s entire liability under any provision of this agreement shall be limited to the amount 
actually paid by you for the software.  Because some states do not allow the exclusion or limitation of liability or consequential or incidental damages, the above may not 
apply to you. 
 

System Requirements: 
 
            Any computer capable of running Microsoft Windows 98 or better has enough processing power to also 
run BarBack.   
 
                                    Minimum                      Recommended 
            Processor        Pentium 90 MHz         Pentium III 300 MHz 
            Memory          32MB                          64 MB 
            Disk Space      30MB Free                  100MB Free 
 
            BarBack requires Microsoft Internet Explorer 4.0 or better. 
 
Disclaimer 
 
This software is meant for people of legal drinking age.  It does not in any way promote under age drinking, excessive drinking, hazing or 
other abuses of alcohol.   
 
The drinks in the BarBack database have been compiled from many publicly available sources as well as from user submissions.  I 
obviously have not tried each and every drink.  If you feel that a drink is not appropriate, please do not make it or drink it.  If you are a 
bartender, please remember your professional responsibility to keep your customers safe.  Many drinks in BarBack are not portioned for 
use in a commercial bar or tavern.  I cannot be held responsible for any damages that my occur in the use of this guide.  I have faith in 
your common sense, that you will use this guide responsibly. 
 
BarBack is not sponsored by, endorsed by or promoted by any particular liquor company or distributor.  All brand names mentioned in 
BarBack are copyrighted by or trademarks of their respective owners.   
 
Think Locally, Drink Responsibly. 
Copyright © 2002, Paul Knorr, All Rights Reserved. 
Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under copyright laws. 
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Technical Support 
 
           World Wide Web 
 
            For database updates, patches, and other information, check the BarBack web site at  
 
            www.barback.com 
 
 
           E-Mail 
 
            For a personal response to a specific problem, e-mail  
             
            support@barback.com 
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Installation 
 
            BarBack has been shipped to you on a single CD-ROM.  In order to work properly, BarBack must first be 
installed on your computer.  The installation program will copy the required files to your hard drive and will also 
create program icons.  To install BarBack follow the instructions below: 
 
For systems running Windows 98, ME, NT or Windows XP 
 
Insert the CD into your CD-ROM drive.  The installation program should start automatically and lead 
you through the rest of the installation process.  If it does not, follow these steps: 
 
1. Click on the start button on the task bar in the lower left corner of the screen.  Select the run command. 
 
 
 
 
 
 
3. Type in where it says “Open:” d:setup and press enter.  If your CD-ROM drive is assigned a letter other than 
d, then replace the d: with the letter for your drive. 
 
4. The setup program should start and lead you through the rest of the installation process. 
 
INSTALLATION NOTE 
 
BarBack requires that Microsoft Internet Explorer (IE) version 4.0 or greater be installed on your PC prior to in-
stalling BarBack.  Versions of Windows from 98 on up come with IE pre-installed as part of Windows.  If you use 
a web browser other than IE (Netscape, for example)  Installation of BarBack will not affect your web browser 
settings. 
 
If you’re installing BarBack on Windows 95, IE 4 or better must be installed first.  The current version of IE is 
available for free from the Microsoft web site at www.microsoft.com 
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Recipe 

Basic BarBack Functions 
 
            When BarBack first starts up, on the left side of the screen is a list of drink names and on the right are 
details about the current drink.  The current drink is the drink that is currently highlighted in the list.   
 
Here are the parts of the main BarBack screen: 

Drink List 

Current Drink 

Drink Name 

Menu Buttons 



Page 7 

1. Viewing a Drink Recipe 
 
            To view the recipe for a drink, simply click on it’s name in the drink list.  Use the scroll bar on the right 
side of the drink list to move up and down in the list. 
            You can also use the keyboard to move through the drink list.  Using the up and down arrows will move 
up and down one drink at a time.  Using the page up and page down arrows will move a full page of drinks at a 
time. 
 
2. Changing Your View 
 
            In BarBack, a view is a way of organizing the drink list.  BarBack has six different views, or six different 
ways of organizing your drinks.   
 
            Use the View menu button to choose the view you want. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            The Views available in BarBack are: 
 
            By Name – Shows an alphabet grid.  Clicking on a letter shows the drinks that start with that letter.  Click-
ing on 0-9 shows drinks that start with a number instead of a letter. 
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            By Liquor – Select an ingredient and all drinks that use that ingredient will be displayed in the list. 
 
 
 
 
 
 
 
 
 
 
             
            By Glassware – Select a glass, and all drinks that use that glass will be displayed in the list. 
 
 
 
 
 
 
 
 
 
            By Category – Select a category and all drinks that fall into that category will be displayed in the list.  A drink 
may be placed into more than one category.  If that is the case, the drink will be listed under each category it is in. 
 
 
 
 
 
 
 
 
            Marked – Shows an alphabet grid and allows you to view all drinks that are currently marked or unmarked 
and that start with the selected letter as in the Name View. 
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            Liquor Cabinet – Shows an alphabet grid and allows you to view all of the drinks that can currently be made.   
 
 
 
 
 
 
 
 
 
 
            View All – This is the default view and the most useful for general use.  It shows all drinks, listed alphabeti-
cally and provides a Quick Search feature.  Typing the first few letters into the Quick Search box will narrow the 
list of drinks down to only the ones that start with the letters you typed.  This is a fast and simple way to find a 
particular drink. 
 
 
 
 
 
 
 
 
3. Searching for Drinks 
 
            There are five different basic ways to search through the drink list to find the recipes you’re looking for.  
The Advanced Search and Find Similar Drinks features are given their own chapter and can be found in 
chapter XIII. 
 
Search options are found under the Search Menu button: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            BarBack will remember your search criteria even as you change views.  For example, if you searched for all 
drinks that contain the words  “on the beach” then afterwards wanted to narrow that down to only the ones you 
can make, simply switch to the Liquor Cabinet view, and the same search will be applied, but limited only to those 
drinks you can make. 
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            Name Search – This will match all or part of the name of a drink.  You can choose to match all instances or 
to only match the first letters.  For example, suppose you enter rum as the text to search for.  If you choose the 
“Match All Instances” option, then you will get a list of drinks including “Rum Runner” and “Bermuda Rum  
Swizzle”.  If you choose the match first letters only option, you would get the “Rum Runner” but not the 
“Bermuda Rum Swizzle” because it does not start with the word rum. 
 
 
 
 
 
 
 
 
 
 
 
            Ingredient Search – This will match all or part of the name of an ingredient and give you a list of all drinks 
that contain the matching ingredients.  The “Match all instances” and “Match first letters only” options work the 
same way as they do when searching by name. 
 
            Recipe Search – This will match all or part of the recipe of a drink and give you a list of all drinks with 
recipes that match the text you are searching for. The “Match all instances” and “Match first letters only” options 
work the same way as they do when searching by name. 
 
            Glassware Search – This will search for drinks that use the glass that you select.  This search is will give you a 
list of glasses to choose from and will then show all the drinks that use that glass. 
 
            Category Search – This will search for drinks that fall into the category that you select.  This search will give 
you the current list of categories to choose from and will then show all the drinks that fall into your selected 
category. 
 
            Clear Search (Show All) - When you’re finished with the search and want to go back to showing all of the 
drinks, use the Clear Search command found under the Search menu.  This will reset the drink list to show all of 
the available drinks.   
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4. Adding a Drink 
 
            To add a drink, choose the “Add” command from the Edit menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
The keyboard shortcut for this command is cA.  After choosing this command, a screen will appear where you 
can enter information about the new drink.  Here is the process step by step: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. After the screen comes up, enter the name of the drink at the very top of the screen.  The drink name 
that you enter must be different from all the other drink names.  Each drink must have a different 
name. 

2. Now you need to add the ingredients.  To enter an ingredient, you first must select the name of the 
ingredient.  The ingredient can either come from the list of existing ingredients on the right, or it can 
be a new ingredient name that you type in where it says “Enter the ingredient name”. 

4. After you select the ingredient, you then need to enter the amount.  The amount should be entered as a 
decimal number.  For example, enter 1.5 instead of 1½.  This will recognize any international settings 
you may have for the decimal place. 

5. After you have entered the amount, you should now select the units.  There are 22 different units you 
can choose from, including metric, English and bar measurements as well as ambiguous measurements, 
such as Part, Piece, Top With or Fill With, that depend on the size of the glass or the type of 
ingredient.  After you have selected the units, click on the Add button.  You will now see your 
ingredient entered in your list of ingredients for the new drink.  To add more ingredients, repeat this 
process.  The ingredients for your drink will always be displayed in the order that you enter them and 
there is no limit to the number of ingredients you can have in a single drink.  To change the order of 
the ingredients, use the Move Up and Move Down buttons.  To remove an ingredient, click the Re-
move button. 
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6. Once all the ingredients are entered, you can move on to the Recipe section.  Here you can enter the 

recipe, select a garnish (or enter a new one), select the Build method (or enter a new one), enter any 
notes or comments, and choose a rating for the drink if you want to. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

7. Next you can chose the glassware to use with the drink.  Choose from a list of 23 different glasses or 
leave it “unknown”.  The glassware images used in BarBack are courtesy of Libby Glass (www.libby.
com).    

 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Now you can choose the categories that this drink will be under.  You can choose as many categories 
as apply. 
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9. Drink Cost and Price, as calculated, are shown.  You can enter the cost and price manually if you think it 
didn’t calculate correctly.  You can also Lock the price, by checking the “Lock the price…” box.  This will 
prevent BarBack from modifying the price when the ingredient prices change or when the drink pricing 
options are changed. 

 
 
 
 
 
 
 
 
 
 
 
 
 

10. The final step to adding a drink is to specify the location of the drink image.  This step is not required and 
can be omitted if you don’t have a photograph of the drink.  If you do happen to have a photograph of the 
drink you’re adding, you can click the “Browse” button to browse to the file that contains the drink image.  
At that point, the image will be shown on the screen, and when you select the new drink in BarBack, the 
image will be shown there as well (only if the template that you’re using supports Drink Images.  See the 
Templates section for more information). 

 
 
5. Editing a Drink 
 
            To edit a drink, choose the Edit option from the Edit menu.  The keyboard shortcut for this command is 
cE.  Drinks can only be edited when you are in the Name View. 
 
            This command will bring up a dialog that is exactly the same as the Add A Drink dialog.  Here you can 
make whatever changes you want, changing the name, ingredients, price, category, recipe or glassware.  Once you 
click the OK button, all your changes are saved.  For details on how to use the dialog, see Adding a Drink. 
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6. Deleting a Drink 
 
            To delete a drink, choose the Delete option from the Edit menu.  When you do this, a warning will appear 
asking if you are sure that you want to delete this drink.  After being deleted, the drink is lost. There is no way to 
undo the command except to add the drink again as a new drink. 
 
 
 
 
 
 
 
7. Printing Drinks 
 
            To print drinks, choose the Print option from the File menu.  The keyboard shortcut for this command is 

cP.  This command will bring up the Print Drinks dialog.   If there are more than 12,000 drinks cur-
rently in the drink list, then a warning will be displayed, and only the first 12,000 drinks will be listed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Printing in BarBack is broken down into two parts:  
 
The Drinks to Print                                                                  And the Layout on the Page 
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Choosing the Drinks 
 

1. Choose the printer you want to use.  The printer that you have set in Windows as the default printer is 
the default printer selected here.  If you want to use another printer, select it from this list. 

2. Select the drinks you want to print.  There is a list that displays all of the drinks that were displayed in 
your drink list when you selected the print option.  To select individual drinks in the list, simply click 
on each drink that you want to print.  That drink will become highlighted and the count of selected 
drinks at the bottom will increase.  To deselect a drink, just click on it again and the highlight will go 
away.  If you want to select all of the drinks in the list, there is a button at the bottom of the list labeled 
“Select All”.  Clicking on it will highlight all of the drinks in the list.  If you want to clear all of the 
selections you made, you can click on the “Clear Select” button and all the drinks that were highlighted 
will be cleared.  

3. Select the tab labeled Layout to change some of the print options. 
4. Now make sure that your printer is on and it has paper then click on the Print button. 

 
Laying out your page 
 
                  Working with Stored Layouts 

 
 
 
 
 

1. BarBack allows you to save a layout you’ve created.  You can save the layout as a new layout by clicking 
the “New Layout button, or you can replace the current layout with the changes you made by clicking 
“Save Layout” 

2. You can choose a saved layout from the dropdown box labeled “Print layout” at the top of the layout 
screen.  Selecting one of the layouts from that list will instantly show you a preview of the page layout 
and the layout of a drink on the page. 

3. If you want to remove a layout, select the layout you want to remove from the list, and click the 
“Delete Layout” button. 

 
            Setting up a Page 
 
 
 
 
 
 
 
 
 
 
1. You can use metric or English measurements to layout the page.  Click on the use Metric measurements box to 

use millimeters, or uncheck the box for inches. 
2. You can set the orientation of the page to either portrait (tall) or landscape (wide) by choosing the desired op-

tion. 
3. You can set the top, bottom, left and right margins by typing numbers into the boxes, or by clicking the up 

and down arrows next to each box.  Clicking Up or Down changes the value by 0.1 inches or 1 mm.  
4. You can set the number of rows by changing the number in the Rows box. You can set the number of col-

umns by changing the number in the Columns box 
5. You can set the space between rows and columns. 
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            Setting up the Drink Layout 
 
 
 
 
 
 
 
 
 
 

 
 
1. There are seven items that make up a recipe.  The name, glass, build, ingredients, recipe, mark and the 

garnish.  Each of these items can be turned on or off except for the name.  Use the check box next to 
each item to turn it on or off. 

2. Each item has a style associated with it.  The style includes the Font Name, Font Size, bold, italic, un-
derline, strikeout and color. 

3. For the glassware you have a choice of printing the name, or a picture.  If you choose picture, you can 
set the height that the picture will print at.  The width is automatically set based on the height. 

4. For the Initials or Mark section, you can place your name or initials or a company name there so that 
others will know that these recipes were printed by you. 

 
Printing Marked Drinks 
 
      To print marked drinks, select the Print Marked Drinks option from the print menu.  The print dialog 
will appear just as it does for normal printing, but the drinks that are available in the drink list are only 
those that are marked. 
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8. Marking and Unmarking a Drink 
 
            The Drink marking feature allows you to quickly get back to a drink that you like or that you thought 
might be interesting.   
 
            Marked drinks can be viewed using the View Marked view and can be printed using the Print Marked 
Drinks command. 
 
 
 
 
 
 
 
 
 
            In the lower right corner of the BarBack screen there is an icon and a button.  The icon is a picture of a 
drink when the drink is not marked and is a picture of a drink with a red check mark when the drink is marked. 
 
 
 
 
To mark the drink, click on the Mark menu and choose Mark Drink.  If the drink is already marked, the menu will 
read Unmark Drink and clicking on it will unmark the drink.  The keyboard shortcut for this command is cM 
to both mark and unmark the drink. 
 
See the Drink Marking chapter for more information about marking all drinks, unmarking all drinks, and 
converting marked drink into a category. 

Marked Drink Unmarked Drink 
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Setting your Preferences and Options 
 
            BarBack has three options that it remembers after the program is shut down: Ingredient Highlighting, 
Default View, and Price Settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ingredient Highlighting 
 
            The Ingredient Highlighting option allows you to display ingredients that you do not currently have in a 
different color from the ones that you do have.  BarBack uses the information entered in the Liquor Cabinet 
section to determine what ingredients you do and do not have. 
            If you uncheck the “Highlight missing ingredients” checkbox, the highlighting will be turned off and all 
ingredients will be listed in the default text color.  If you leave the box checked, you can then click on the raised 
“color box” next to it.  This will bring up a color selection dialog where you can select the color you want the 
missing ingredients to be highlighted in. 
 
Default View 
 
            If you want BarBack to always start up in a particular view, you can select that view here.  If you want 
BarBack to come up with the view that was most recently used, select the bottom option “Default to most recently 
used view.”  This will bring BarBack up with the last view that you were using.  BarBack does not remember any 
searches that you had when it was shut down. 
 
Measurements 
 
            BarBack allows you to select the units of measurement that you are most comfortable with.  If you choose 
English, then drinks will be displayed with English measurements.  The only exception being those drinks that 
were originally entered in metric units or those drinks that are independent of units (parts, pieces, slices, etc...) 
            If you choose metric units, then drink recipes will be displayed with metric units with the same exceptions 
above for English units. 
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The Liquor Cabinet 
 
            The Liquor Cabinet will allow you to select all the ingredients that you have on hand and will then generate 
a list of all the drinks that you can make.  
 
Here is what the Liquor Cabinet dialog looks like: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Selecting Ingredients 
            To select an ingredient, place a check mark next to it by clicking on the box.  You can select individual in-
gredients or entire categories.  To unselect an ingredient click on the check mark and the check mark  will go away. 
 
Save 
            You can save the list of selected ingredients without doing a search.  We understand that selecting all the 
ingredients you have on hand can be a tedious process, so if you get tired, simply save what you’ve done.  You can 
then come back to it later. 
 
Print 
            If you want a printed report of what you have on hand, choose the Print option.  This is useful for doing a 
manual inventory, or just as a checklist. 
 
Canceling 
            While the Liquor Cabinet feature is busy matching drinks, you can click on the cancel button at any time to 
interrupt it.  Any matches it had found up to that point will still be kept. 
 
            Finally, when the Liquor Cabinet is finished checking all the drinks, you will be returned to the main 
BarBack screen with the drink list with the list now filtered to show only the drinks you can make. 
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The Shopping List 
 
            The Shopping List is a feature of BarBack that allows you to select drinks and the approximate number 
of drinks that you plan to make and from that information, create a shopping list with all of the different 
ingredients used by your selected drinks and the amounts of each that you will need. 
 
The Shopping List dialog looks like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The available drinks are in the list on the left and the selected drinks are in the list on the right.  To add a drink to 
the selected list, you can double click on it, or you can highlight it and click on the -> button.  The <- button 
removes the drink from the selected list as does double clicking on the drink in the selected list.  The ->> and 
<<- buttons move the entire drink list to and from the selected side.  You can highlight more than one drink at a 
time and use the -> button to add or remove them. 
 
Estimating The Number of Drinks 
            An average person that drinks will have between 2 and 5 drinks at a party.  This is based on personal 
observation and not on any statistical information that I know of.  When entering the number of drinks, I use 
this equation:  Take the number of guests that you expect, multiply that by the number of drinks you expect each 
guest to drink (on average), then divide that by the number of drinks that you have selected. 
            This is only a rough estimate of course.  You will have to use your best judgement as to the popularity of 
certain drinks over others and the drinking capacity and habits of your guests. 
 
Measurements 
            Once you have selected the drinks you want, and estimated the number of drinks, then you can select the 
type of measurements to use.  The measurements are in Bar (Fifth, Pint, etc...), English (Gallon, Quart, Pint, 
etc...) and Metric (Liter and milliliter).  Pick the one that you feel is appropriate for where you will shop. 
 
Make List 
            Clicking on Make List will generate the shopping list.  If you change any of you settings, clicking on Make 
List again will update the shopping list. 
 
Clear List 
            This will clear the list of selected drinks. 
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Print 
            This will print your shopping list.  You also have the option of printing the recipes for the drinks you 
selected as well. 
 
Save List 
            Once you have the shopping list the way you want it, you can save it.  The default extension for a saved 
shopping list is .LST. 
 
Open List 
            If you want to bring  up a previously saved shopping list, you use the Open List button and browse until 
you find the shopping list you are looking for.  This will read in the list, set the selected drinks, set the estimated 
number of drinks and set the measurement method for you.  You can then print or change any of the settings. 



Page 22 

Working With Ingredients 
 
            There are over 24,900 drinks in BarBack with over 1490 different ingredients.  To help organize this list of 
ingredients, the list is broken down into types and sub types.  Ingredient types and sub types are completely 
customizable.  You can add edit and delete any of the types with only one exception.  You cannot delete the 
“Undefined / Other” type or sub type.  This is used internally by BarBack and must be present. 
 
            To change the ingredient types, you use the Ingredient Type dialog which is under the “Edit Ingredient 
Types” command in the Tools menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            To change the type of an ingredient, select the ingredient you want to change from the list at the top.  
Then select the new type from the combo box at the bottom.  The ingredient will be updated automatically. 
 
Editing the Ingredient Types 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Changing an Existing Type 
 
            To change an existing ingredient type or sub type, expand the tree out so that the one you want to edit is 
visible.  Click on the item (you may have to click on it more than once) to put it in “Edit Mode” (as the Dark Rum 
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item in above) type in the new name and press enter.  The ingredient type or sub type will be updated with your 
changes. 
 
Adding an Ingredient Type or Sub Type 
 
            To add a new ingredient type, Click on the Add Type or Add Sub Type buttons, type in the name and 
press enter.  Add Sub Type will place the sub type under the currently selected type. 
 
Removing an Ingredient Type or Sub Type 
             
            To remove an ingredient type, highlight the type or sub type that you want to  remove and click on the 
Remove button.  This will take the type out of the list.  It will also set any ingredients that use that type to be 
changed to the “Undefined / Other” type or sub type.  you will then need to go back to the Edit Ingredients 
dialog and change the “Undefined / Other” types to another type (if you want to).  Please note that the remove 
cannot be undone.  If you remove an ingredient type and then add that type back again as a new type, all of the 
ingredients that were made undefined when you deleted the type will still be undefined, so use this carefully. 

29 
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Editing The Ingredient List 
 
            BarBack gives you the ability to set a drink’s price based on it’s cost.  To determine that cost, BarBack 
must know the cost of the ingredients.  For BarBack to know the cost of each ingredient, you have to tell it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            To bring up the Edit Ingredients dialog, choose Edit Ingredients from the Tools menu. 
 
Name—You can edit the name of a selected ingredient by clicking on the Ingredient column  
Units—You can select the units that the ingredient comes in (Say a 1 liter bottle, or a Gross).  If the unit is one 
that you’ve used before, the Ounces per unit (ounces) column will be set automatically. 
Ounces—This is the ounces per unit.  It’s used to calculate the cost of the ingredient. 
Price—This is the cost of 1 unit (as specified in the units column) of the ingredient   
Type—This is the Ingredient type.  Select the type from the drop down list. 
Sub Type—This is the Ingredient Sub type.  Select the sub type from the drop down list after you’ve selected the 
type. 
Notes—This is a section for any notes you might want to add about an ingredient.  The note is limited to 255 
characters. 
 
Add—Add a new ingredient 
Remove—Remove the selected ingredient 
Merge—Merge one ingredient with another.  The ingredient you select will be removed and everyplce that it was 
used will be replaced with the ingredient you choose to merge it with. 
Usage—Shows you the names of the drinks that use the selected ingredient. 
Types—Allows you to edit the ingredient types. 
Save—Saves the changes you’ve made 
Cancel—Does not save the changes you’ve made. 
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Working with Drink Categories 
 
            BarBack organizes drinks into several different categories.  The Drink categories work much the same way 
the ingredient categories do.  To change a drink’s category, edit the drink as described in the “editing a Drink” 
section.  To add or remove categories or to change the description of a category, choose “Edit Drink Categories” 
from the Tools menu. 
 
  
 
 
 
 
 
 
 
 
 
 
 
Changing an Existing Category 
 
            To change an existing drink category, highlight that category in the list at the top.  The category will be 
displayed in the edit control at the bottom.  Make the changes that you want in the edit control and then click on 
the Update button.  The drink category will be updated with your changes. 
 
Adding a Drink Category 
 
            To add a new drink category, enter the description of the category in the edit control at the bottom.  Then 
click on the Add button.  This will append the new category to the end of the list.  After adding a category, you 
will then need to edit any drinks that you want to have use that category and change their category to the new one 
you just added. 
 
Removing a Drink Category 
 
            To remove a drink category, highlight the category that you want to  remove and click on the Remove 
button.  This will take the category out of the list.  It will also set any drinks that use that category to be changed to 
the “Undefined / Other” category.  you will then need to go back and edit the drinks with the “Undefined / 
Other” category.  Please note that the remove cannot be undone.  If you remove a drink category and then add 
that category back again as a new one, all of the drinks that were given undefined categories when you deleted the 
category will still be undefined, so use this carefully. 
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Using the Drink Price Worksheet 
 
            The drink price worksheet is used to set the prices of all drinks at once.  It is also used to update the drink 
costs when the ingredient prices are changed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Beverage Cost Method 

      Based on the book Successful Beverage Management by Robert Plotkin.  Set the percentage that you want 
the cost of the drink to represent.  For example, if you want the beverage cost to be 10%, then a drink that 
costs $1, will be priced at $10.  That way, the cost is 10% of the price.    

Percent Markup 
      This option sets the drink price as a percentage markup from the cost.  For example, if a drink costs $1.04, 
a 100% markup would make the price $2.08.  If you want drink prices to be equal to the cost, you can enter 0 
as the percentage.   

Percent Increase 
      This option allows you to set the price as a percentage of the current price.  For example, if a drink is 
currently priced at $3.00 and you apply a percent increase of -50%, the new price will be 50% lower then the 
current price or $1.50.  Negative numbers indicate a markdown and positive numbers indicate a markup. 

 
Apply only to drinks with a price of 0—This option allows you to only set the price of drinks that have not yet 
been set.  If the drink price has not been set and is still 0, then this will apply the new drink price.  If the drink 
price has  already been set then it will be left alone. 
Round calculated prices to—This combo box lists six possibilities for rounding the drink price.  You can round 
the price to the next Dollar (or whole unit of currency), .50, .25, .10, .05 or .01.  The last option really means don’t 
round the price at all.  The drink price is always rounded up and is presented using the international settings found 
in Windows for currency symbol and format. 
Force minimum price—This option has two parts.  First is the check box which indicates if you want a 
minimum price or not.  If the box is unchecked, then whatever is entered in the edit control is ignored and no 
minimum price is applied.  If the box is checked, then the price that is entered in the edit control is used as a 
minimum price for all drinks that are being set.  The minimum price must be greater than or equal to 0. 
Edit Ingredient List—Allows you to edit the ingredient list and change the ingredient prices. 
Update Prices—This will go through all the drinks (or only those with a price of 0) and will update the price, 
applying the rules that you have set.  If a drink has the “Lock Price” option set, then the price for that drink will 
not be changed. 
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Exporting the Drink List 
 
            NOTICE: This feature is provided for your convenience.  This drink list is copyright © 2002, by Paul Knorr and cannot be reused without 
permission.  This includes use in another bartender's database program, printed book, or posting on the Internet. 
 
            In order to make it easier to share drink recipes with others, and to use the recipes in other applications, 
BarBack supports to export formats other than the built in BarBack Drink Exchange (BDX) format.  They are 
Maitre’D Point of Sale system format, and Extensible Markup Language (XML) format. 
 
Maitre’D Export                                                                      XML and BDX 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ASCII Text Format 
 
 
BDX File Export 
            The BarBack Drink Exchange file (BDX) is a plain text file with a special format that can be read and 
created by BarBack.  It is used to exchange drink recipes with other users.  A collection of BDX files can be found 
at the BarBack web site at www.barback.com  The specification for the BDX file format can also be found at the 
web site.  It is an open specification and can be used by any other programmer who wishes to support BDX files. 
            To export or  create a BDX file, you first enter the file name in the box at the top.  You then must select 
the drinks that you are going to export. 
            You can export all marked drinks, all drinks in a category, or you can select any drinks from the complete 
list. 
            After you have selected the drinks you are going to export, click on the OK button and BarBack will create 
the BDX file 
 
BDX File Import 
 
 
 
 
 
 
 
 
            To import a BDX file into your current drink database, simply enter the file name of the BDX file, or use 
the Browse button to select it.  Then click on the Import button.   
            As the import is performed the number of drinks added and the number of drinks ignored is shown on 
screen.   
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            Drinks are added and ignored based solely on their name.  If a drink exists in your database with exactly 
the same name as the drink that is about to be imported, then that drink will be ignored. 
 
Maitre’D File Export 
            The Maitre’D recipe.txt file is a plain text file with a special format that can be read and created by the Mai-
tre’D point of sale system created by Posera.  It is used to display the recipe of a selected drink.  To export or  
create a Maitre’D file, you first enter the file name in the box at the top.  You then must select the drinks that you 
are going to export. 
            Maitre’D files are limited in size to 64K (about 65535 bytes) You can have BarBack limit the size of the file 
for you, so the export stops when the file gets too large, or you can just export a large file, but Maitre’D will only 
read the first 64K of it.  Also, to conserve space, you do not have to export the recipe or description of the drink. 
            You can export all marked drinks, all drinks in a category, or you can select any drinks from the complete 
list. 
            After you have selected the drinks you are going to export, click on the OK button and BarBack will create 
the Maitre’D file 
 
XML File Export 
            XML Export works the same as the BDX file export.  XML Files can be read by a large number of 
other programs including spreadsheets, databases, web browsers and word processors 
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Units Conversion and Reference 
 
            In an effort to make BarBack more useful to those people who use the metric system, BarBack now 
includes a unit conversion tool to convert English and metric measurements.  This conversion tool is limited to 
English and Metric units of fluid measurement only. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            The unit conversion tool is found under the Unit Conversions option on the Tools menu.  It can convert 
English to metric, metric to English, English to English and metric to metric. 
            To use the conversion tool, first enter the amount that you want to convert.  Then select the units that the 
amount to be converted is in.   
            Then select the units that you want to convert to.  The area with the converted amount will be filled in 
when you click on the Convert button. 
 
Reference  
 
            This is really just a collection of equivalent measurements for English, metric, and other more esoteric 
units.  It includes the volume of beer kegs and cases, wine carafe’s, and standard liquor bottle sizes, among other 
things. 
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Advanced Search 
 
 
            The Advanced Search feature is the most powerful search engine available to bartenders.  It allows you to 
enter up to five criteria that each drink must meet in order to be listed as a match for your search.  The criteria can 
be any combination of name, ingredients, category, glassware, marked, price, cost, comment, rating, build, garnish 
and recipe. 
            The Advanced Search will also allow you to save your search for future use. 
 
 
 
 
 
 
 
 
 
 
 
 
Creating a New Search 
 
            To begin creating a new search, first choose the field.  This can be either name, ingredients, category, 
glassware, marked, price, cost or recipe.   
            Next, choose the comparison.  Only those comparisons that are appropriate for the selected field will be 
displayed.  For example, if your field is name, then  the comparisons will be Is Equal To, Starts With, Ends With 
or Contains the Word(s).  If you chose Marked as you field, then your only comparison would be Is Equal To. 
            Finally, enter or choose the value to search for.  For those fields where there are a limited number of 
possibilities (i.e. Category, Glassware...) a list will be given that you can pick from.  For those fields where anything 
can be entered (Name, Ingredients, Recipe...) a space will be provided for you to enter a word or phrase. 
            You can now repeat this process up to four more times. 
            Once you are finished, click on the Search button to have BarBack start searching. 
 
Retrieving a Saved Search 
 
            To retrieve a saved search, simply pick it’s name from the list at the top of the dialog. 
 
Saving a Search 
 
            After you have finished entering your criteria, you can save the search by clicking on the Save button and 
giving your search a name.  After that, it will appear in the list at the top of the dialog.  
 
Deleting a Saved Search 
 
            To delete a saved search, first retrieve the search then click on the Delete button. 
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Find Similar Drinks 
 
 
            The Find Similar Drinks feature uses the Advanced Search to find drinks with the same ingredients a the 
current drink.  Choose Find Similar Drinks from the Search menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            BarBack will automatically display the Advanced Search dialog, already filled with the ingredient names 
from the current drink.  Only the first five ingredients will be entered if there are more than five.   
            You can then choose Search to find drinks that have the same ingredients as the current drink. 
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Drink Marking 
 
 
            BarBack supports three special Marking features to help you control and organize your drink recipes. 
 
 
 
 
 
 
 
 
 
 
Mark All 
 
            Mark All can be found under the Mark menu.  It will mark all of the drinks in the current list.  This works 
much the same way the printing works.  If you do a search, and then choose Mark All, only those drinks that 
matched your search will be marked - only the drinks that were in the list. 
 
Unmark All 
 
            Unmark all can be found under the Mark menu.  It will unmark any drink that is marked regardless of 
whether it’s in the current list of drinks or not. 
 
Convert to Category 
            Convert to category will take all of the drinks that are currently marked, and will place them into the 
same category.  When the convert to category dialog comes up, you can choose an existing category, or you 
can click on the Edit Categories button and create a new category.  This makes it very easy to create new 
categories of drinks. 


